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Objective

* The main objective of this hands-on exercise is to extract water body
areas using Sentinel-2 imagery.



How to map flood areas from Sentinel-2 data?

* Open data product

* Create a subset image

* Calculate NDWI

e Extract water areas using threshold

* Export result to other format (ex. tif) for map layouting






Open Sentinel-2 data

Use the Open Product button
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Open Image Window
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[ XN ] Select RGB-Image Channels

Profile:

Sentinel 2 MSI Natural Colors L |

Red: B4 <

Green: B3 o]
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Blue: B2

Store RGB channels as virtual bands in current product
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Creating a subset image

From the Raster menu, select Subset...

® ® Resampling
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Source Product
Name:
[1] S2A_MSIL1C_20170528T050611_N0205_R076_T44NMM_20170528T050606 ﬁ

Target Product
Name:

S2A_MSIL1C_20170528T050611_N0205_R076_T44NMM_20170528T050606_resampled

Save as: BEAM-DIMAP S
Directory:
/Users/dantran/Desktop/Forest Mapping

Open in SNAP
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Define size of resampled product
© By reference band from source product: B2
Resulting target width: 10980

Resulting target height: 10980

By target width and height: Target width:

Target height:

Width / height ratio: 1.00000
By pixel resolution (in m):

Resulting target width: 1830

Resulting target height: 1830

Upsampling method: Nearest
Downsampling method: First
Flag downsampling method: First

Resample on pyramid levels (for faster imaging)
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Creating a subset image

@® Specify Product Subset 00 ® Specify Product Subset 00 ® Specify Product Subset
Band Subset = Metadata Subset Spatial Subset etadata Subset Spatial Subset  Band Subset
m Geo Coordinates Bl Reflectance in band B1 Abstracted_Metadata
B2 Reflectance in band B2 Level-1C_User_Product
Scene start X: 2738 : B3 Reflectance in band B3 Level-1C_DataStrip_ID
~ B4 Reflectance in band B4 Granules
Scene start Y: 1110
BS Reflectance in band B5 Processing_Graph
Scene end X: 6660 ° B6 Reflectance in band B6
Scene end Y: 4958 ¢ B7 Reflectance in band B7
B8 Reflectance in band B8
. N B8A Reflectance in band BSA
Scene D X: 1 : B9 Reflectance in band B9
STECE G 1 B10 Reflectance in band B10
gzz:zt :EE:: :Iv:ljt:t ;gi;g B11 Reflectance in band B11
Source scene widgth: . 1098.0 B12 Reflectance in band 512
Source scene height: 10980 view_zenith_mean  Viewing incidence zenith angle
Fix full width view_azimuth_mean Viewing incidence azimuth angle
Use Preview
Fix full height Select all Select none Select all Select none
Estimated, raw storage size: 525.3M Estimated, raw storage size: 453.4M Estimated, raw storage size: 453.4M
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Calculate NDW!|

From the Raster menu, select Band Maths
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Extract water using threshold
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Export result to other format for further analysis ¢/

From the File menu, select Export, hen select GeoTIFF
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<> EEIID == K- B2 B J Q. Search
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— » 9 S2A_MSIL1C_201705...70528T050606.data Nov 11, 2019 at 00:17 -- Folder
) . E S2A_MSIL1C_201705...170528T050606.dim  Nov 11, 2019 at 00:11 8.5 MB SNAP s...IMAF
> iCloud Drive ¥ S2A_MSIL1C_201705...170528T050606.zip  Oct 25, 2019 at 00:32 630.6 MB  ZIP archive
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Advanced Preparation for the Training Course : “How to process
satellite data (optical and SAR) to produce VAP with particular foci

on flood and water-related disasters”
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(1) Installing the QGIS software into your personal computer.

1.1 Copy and paste the following link in a web browser

https://qgis.org/en/site/forusers/download.html

1.2 Goto All releases and find an installer (QGIS 3.4.8 version is preferred) depending on your system specification

C @

qgis.org

DISCOVER QGIS

FOR USERS

GETINVOLVED  DOCUMENTATION

Previous releases of QGIS are still available here - including older releases for OS X here
More older releases are available here & and for OS X here o'

Plugins for QGIS are also available here &"

g f L =

1f not stated otherwise, all content is licensed under

Select graphics from

Uniransiated page? Or you spot a transiation error

Textual error, missing text or you know better

Eg: Windows
64bit

@ Index of /downloads X

< &

: Apps n Lag into Faceboaok |...

Mew Tab
oads/

& qgis.org/down

B (1) YouTube

QGIS-05GepdW-3 4 6-2-Setup-x86.exe

@ QGIS-05GepdW-3 4 6-2-Setup-x86.exe.mdisum
QGIS-08GeodW-3 4 6-2-Setup-x86_64. exe

@ QGIS-05GeodW-3 4 6-2-Setup-x86_64.exe mdisum
QGIS-08GeodW-3 4 7-1-Setup-x86.exe

@ QGIS-05GepdW-3 4 7-1-Setup-x86 exe mdisum
QGIS-05GepdW-3 4 7-1-Setup-x86_64 exe

@ QGIS-05GepdW-3 4 7-1-Setup-x86_64 exe mdisum
QGIS-05GepdW-3 4 §-1-Setup-x86. exe

@ QGIS-05GeodW-3 4 B-1-Setup-x86 exe mdisum
QGIS-05GeodW-3 4 B-1-Setup-x86_64 exe

@ QGIS-05GepdW-3 4 8-1-Setup-x86_64 exe mdisum
QGIS-05GepdW-3 4 9-1-Setup-x86 exe

@ QGIS-05GepdW-3 4 9-1-Setup-x86 exe mdisum
QGIS-05GeocdW-3 4 8-1-Setup-xf6_64 exe

1.3 Download the installer (32 bit/64 bit) according to operating system and install the software.

x Spotify — Sea

EE EarthExplorer €3 New Script - Earth...

28-Mar-2019 02:55 446M
28-Mar-2019 02:55 69
28-Mar-2019 03:11 483M
28-Mar-2019 03:11 72
20-Apr-2019 12:27 446M
20-Apr-201912:27 69
20-Apr-2019 12:44 483M
20-Apr-201912:44 72
18-May-2019 02:47 445M
18-May-201902:47 69
18-May-2019 02:35 482M
18-May-201902:35 72
22-Jun-2019 10:51 445M
22-Jun-2019 10:51 69
22-Jun-2019 10:59 482M


https://qgis.org/en/site/forusers/download.html

(2) Installing Orfeo toolbox for remote sensing image processing

1.1 Copy and paste the following link in a web browser

https://www.orfeo-toolbox.org/download/

& [¢] L:rfeu-too\k:ox‘crg download,

i Apps “ Loginto Facebook .. @ (1) YouTube EE Earthixplorer & NewScript-Earth.. & Google Earth Engine @) Sentinel-2 for Agric. O Google Earth Engine Perfect Symphony .. & Wark with the Diffe drone quitar computer @ Sentinel Asia » Other bookmarks

t ‘ O rfeo TO 0 I B 0 X Forum  Download  Documentation  Blog  Community

Orfeo ToolBox is not a black box

Choose installer according to
your operating system and
download.

Download

ORFEQ ToolBox is distributed as open source under an 0SI-approved license. Starting with OTB 6.0, the Apache 2.0 license is used. For prior versions, the CeCILL v2 licence is
used. On all platforms, the OTB standalone package contains everything: applications for command line and graphical user interface, python bindings, Monteverdi and also
official remote modules

Eg: Windows 64 bits

Installation Instructions

Notes for Windows install

We provide standalone binaries for Windows which do not require administrative privileges. Download the archive below (32 or 64 bits), and extract it somewhere. Double-
click on the monteverdi batto launch Monteverdi, or mapla.bat for the OTB application browser. Please see the CookBook for detailed installation instructions (You may
need to right click - > save as..)

Tips: Use 7-Zip for faster extracting speed (extraction should take around 15 seconds with 7-zip, but can take up to lo minutes with the default extractor).

Notes for Linux install
Alternatively, OTB is also available via package management system on some Linux distributions:

s Debian
» Ubuntu
» OpenSUSE (sponsored by SIRS)


https://www.orfeo-toolbox.org/download/

Share View Compressed Folder Tools

[ 2« e B X =]

=8

%Newitem -

v

w-| Copy path ﬂ Easy access - Edit
Pinto Quick Copy Paste Move Copy  Delete Rename Mew Properties .
access ‘1] Paste shortcut tor  to- - folder - £ History
Clipboard Crganize Mew Cpen
4N » ThisPC » GIC(D:) » 2019 » 21_JPTM_workshop » Orfeo_toolbox
~
Name
st Quick access
{8 ote-7.0.0-Wins4
@ OneDrive - ait.asia
E This PC
“J 3D Objects
| 4 [ = | OTB-7.00-Wing4
Home Share View
* Ij 4 cut x 7 New item = @ Open FH select al
w-| Copy path ﬁ Easy access ~ Edit Select none
Pinto Quick Copy Paste - Move Copy Delete Rename MNew Properties ) .
access EI Paste shortcut ta to - folder - £ History EFInvert selection
Clipboard Crganize Mew Open Select

« = v 1 » ThisPC » GIC(D:) » 2019 » 21_JPTM_workshop » Orfeo_toolbox » OTB-7.0.0-Wingd » OTB-7.0.0-Wingd
~
Narme Date modified Type Size
7 Quick access
bin File folder
@ OneDrive - at.asia include File folder
I This PC lib File folder
X mkspecs File folder
_J 3D Objects
plugins File folder
B Deskiop share File folder
5| Documents tools File folder
* Downloads translations File folder
D Music [ LICENSE File
| Pictures [l mapla Windows Batch File
m Videos monteverdi Windows Batch File
w08 (g i ore Project WinRAR ZIP archive
- : [ otbenv.bash BASH File
- GIC (D) otbeny Windows Batch File
ws Chathumal (F:) Q README File

- MNew Volume (G:) start_devenv Windows Batch File
== Materials-Current Training (\\titan) (V)
=g chathumal (\\kepla\Kepler\D-Temp_Auto_Del_30days) (X:)

== Kepler (\ikepla) (V:)

MOpen <

1KB
2KB
2K8
A4 KB
2KB
2KB
3KB
2K8

FH setect an

Select none
I:ID Invert selection
Select

Date modified

11/4/2019 4:25 PM

~ | @ Search OTB-

Type
WinRAR ZIP archive

w @ | Search Orfeo_toolbox 2

Size

132,369 KB

<+«——— 1.2 Extract this
downloaded file.

1.3 In the extracted
folder you will see folders
like below. Copy all the
files in the extracted
folder.

1.4 Create a folder in C drive (
according to your preference) and
paste these files in a folder and
name it as OTB



1.5 Open QGIS software and click on Plugins

@ Untitled Project - QGIS

(EEREY (L2 AP, A, BBER @6 -5 o-5
RESV.ZW D : &

Browser (=]E] Recent pmjects
GryYmTo
Favorites

b [a] Home
Y
b DN
b EA
r [ FA
]G
CER"AY
¥
v [ ZN

e GeoPackage

f Spatialite

@ Postols

P mssal
g9 »
Layers (2]

o @l ® T - AL

Q, Type tolocate (Ctrl+) Ready

¥ =00
QaR 20

Coordinate

W scale :20854291 |~

ﬁ Magnifier  100%

— X

Processing Toolbox ®
B a 02 Ty

Q, search

) Cartography

() Database

2 Filetools

() Graphics

@ Interpolation

() Layertools

() Network analysis
() Raster analysis
() Raster terrain analysis
) Raster tools

) Vector analysis
) Vector creation
() Vector general
() Vector geometry
() Vector overlay
() Vector selection
() Vector table

[

Results Viewer ®

“| Rotation 0.0° +| V| Render @ EpsGiazze @



1.7 Add these details in the following tabs.
1.6 Goto Plugins > Settings Click Add under Plugin repository
Name: Orfeo Repository
Y — v URL : http://orfeo-toolbox.org/qgis/plugins.xml

All Check for updates on startup Q Repository details >
: Installed every time QGIS starts -
Mame Orfeo Repository
Note: |$ tno duvytiov to evaBAsd, BMIE wiAA vopu wou wnevemep a vew mAvyty op

Mot installed nmAvyy unbate w awatdaBie. OTnEpuwios, eTynvy penootToples wAA Be nepdopped , N . i

buptwy onsvivy o the NMAvywy Mavayep wivdow. URL |htt|:|.ﬂor1’eo toolbo}(.orgfqglsfplugms.m“
Invalid SR

v i @ T Parameters qgis=3.6
Install from ZIP Authentication Clear Edit

Note: EEnspipevtald mAvyiva ape yevepaAdy vvom taBAs gop npobuyTiov vos. Theos

MAUYIVG apE IV £QpAlp oTayso of SE@EAonUEVT, avh onovAd B yovolOspeld SIVYOUNASTES
op 3Mpood of YOUYENTS TOOAD. BMNZ 600 VOT PEYOUUEVD (VOTTAAVY THEDE MALYLVD Enabled W
UVAEOT WoU IWTEVD TO UOE THEU §op TETTIVY MUPTOTED.

v Show also deprecated plugins

Note: Asnpsyatsd nAvywvo ape yevepaddyw vvouvttafis dop npoduyTiov voe. Tneos
nAvyva ape vvpavtatved, avd onovAd Be yovolbeped 3o0fooAeTes TooAa. BIE doso vot
pexoupsvd wotalAwvy Tneoe mAvywo vwAsoo wou oTIAA veed 1T avl THEPE aps vo oThEP
aAtepvaTimer amatAafAs.

Plugin repositories / | Ok Cancel
Status Name URL
@ connected QGIS Official Plugin Repository https://plugins.qgis.erg/plugins/plugins.xml?qgis=3.6 After addlng Info rm atlon Press OK
Plugin repositories
Status Marme URL
1 r @ connected Orfec Repository http://orfec-toolbox.org/qgis/plugins.xml?qgis=3.6
Reload all Repositories add Edit_ Delete @ connected QGIS Official Plugin Repository https://plugins.qgis.org/plugins/pluginsxml?ggis=3.8
Close Help
1 »
Reload all Repositaries Add.. Edit ... Delete

Click Add



1.8 Goto Plugins > Manage and Install Plugins

(2} Plugins | All (439)

Mot installed

Inwvalid

B

Inztall from ZIP

ﬁ Settings

L oth

# Processing OTB provider

Processing OTB provider

Processing provider to use OTB applications

Orfeo ToolBox {OTB) is an open-source project for state-
of-the-art remote sensing. It can process high resolution
optical, multispectral and radar images at the terabyte
scale. A wide variety of its applications such as Mosiac,
Ortho-rectification, Pansharpening, Classification, Deep
Learning {via tensorflow) are accessible in QGIS through
this processing provider. OTB 6.6.0 or higher is required to
use this plugin

gl gl gl alle ol

More info homepage
Author CNES

Available version 1.4.2

1
Upgrade Al Install Plugin

Close Help

1.9 Type otb in the search
bar and click on install
plugin



2.0 Goto Settings > options > Processing

() Options | Processing

>
. ] Setting Value . . - & O
o b 4 Generl 2.1 Click on Providers and select A ;
Colors
b = Menus Reset to defaults s
= OTB € Geoid file
ﬂ Digitizing v #: Models &b Logger level INFO
s ~ ¢ Providers - & Maximum RAM to use
ﬂ mins » i GDAL & OTE application Folder: L]
&15 GDAL b 4@ GRASS € OTE folder
' v &b Ot € SATM tiles folder
Variables ¥ 6 SAGA
B aunenicaion  [IERSRR 2.2 Click here and click on

—T Network

Add on the Multiple selection

Locator ta b .
A Advanced

(2} Multiple selection \ et
Acceleration
Add
oK Cancel Help Remave
Remove all
oK |
Cancel
~ €& OTB v
€ Activate v C“u:: ) . N x|
| \
€ Geoid file « v 1 > ThisPC > OS(C) » OTB » lib » otb > applications v @&  Search applications p :
& Logger level INFO ‘ Organize »  Newfolder - @ |
& Maximum RAM to use | E e A Nome h Date modified Type Size :
&b OTB application folder C:/OTB/lib/otb/applications 8 3D Objects Mo items match h :
€ OTB folder | moske \
€ SRTM tiles folder \ poeumens ‘
+rems 2.3 Browse to the ‘
| Ere i i ‘
: = fiews application folder and
2.4 Click here and do the same - plp + i th - |
S select It, In the previous
process and select the OTB | msew d’OTB ¢ Iz | Y
. . = chathumal (F) Cre ate O r
folder this time | T—
= Materials-Currer
= chathumal ke
= Kenler (kenlsl ¥
Folder: | applications 4

Select Folder Cancel



Then you can access all the tools under OTB

* & OB

-

b A R . S T . . .

OTB toolbox installation procedure is same for the

Calibration

Change Detection
Deprecated

Feature Extraction
Geometry
Hyperspectral
Image Filtering
Image Manipulation
Learning

SAR

Segmentation
Stereo

Vector Data Manipulation

other operating systems.

Processing Toolbox

'*‘3{[’ L) +

- - &

Sear

q - v v

4

i v v v v -

v v v v v w

m GDAL

4 GRASS
¥ Models
& oTB

Calibration

Change Detection

Deprecated

Feature Extraction

Geometry

Hyperspectral

Image Filtering
&b ContrastEnhancement
&b Despeckle
& DimensionalityReduction
& DomainTransform
& ImageTimeSeriesGapFilling
D MeanShiftsmoothing
& Smoothing

Image Manipulation

Learning

SAR

Segrmentation

Stereo

Vector Data Manipulation

P & SAGA

& )




(3) Adding base maps for QGIS

1.1 Goto Plugins > Settings Click Add under Plugin repository

1.2 Type QuickMapServices in the search bar

(2 Plugins | All (439)

ﬁ All

|

| 2
E ] nstalled
e

Mot installed

Invalid
o

w'm

Install from ZIP

ﬁ Settings

QuickMapServices

Collection of easy to add basemaps

Convenient list of services + search for finding datasets an¢
new services via <a href="http://gms.nextgis.com'=http://q

MNextGIS.

LI TI0T 659 rating vote(s), 1304020 downloads

Tags

More info

Author

Available version

1

Upgrade All

geojson,wms,qms,openstreetmap,inter

homepage bug tracker code reposit

NextGIS
0.19.10.1

Install Plugin

Close

Help

1.3 click on install plugin



1.3 Goto Web > QuickMapServices To access the Base maps.

() *Untitled Project - QGIS

Project Edit View Layer Setting:

DB R&
LA YA

L2vme
Favorites

[&] Home

ey

[ b

v 7 BN

(RS

[ G\

[ImR'AY

[ImR'AY

[z

@ GeoPackage

/7 Spatialite

@ postals

« 4l ® T 2 3= g

- ¥ Filtered Grid
W -29605%-15
1
b ¥ Flood tresh

- ¥ Converted
W
1
- W tests

[ [l
1

- ¥ Converted
Mo
1
- ¥ Flood tresh_int
Mo
1

Q. Type to locate (Ctrl+)

s Plugins Vector Raster Database

U@ ppmi

Browser 5]

Layers 5]

1legend entries removed.

+ QuickMapServices

LY Mesh Progessing Help
MetaSearch

|

»
»

@ 2gis

b AutoMavi

b Bing

B R

@ GeoQ

[ Geofabrik

& Google

m Kosmosnimki.ru
& Portugal

¥ Landsat

1¥ MapSurfer. NET
) Mapbox

@ NAsA

4 Georgia

# CartoDB

% Rosresstr
' OpenSeaMap
£ Sputnik

4 Stamen
strava

F4 uses

<2 TianDiTu

% Genshtab
=% Ukraine Cadastre
£ Waze

9 VYandex

3 Bergfex

EJ etlas Mos

# OsM

) search QMS

£} Add to Search
@ Set proper scale
@ Settings

@ About

¥ T m
QOeOR 2O

Coordinate . 94858,2086670 % Scale | 1: 708040

-

ﬁ Magnifier | 100%

Results Viewer

~ Rotation

0o=

v Render

& EPSG:32647

(-]

BE




Thank you



Flood Extraction Using
ALOS 2 PALSAR 2 Data

Chathumal Madhuranga (AIT)



Methodology behind the Flood extraction

/ Pre-image / / Post-image /
N 3
Differential
image

Thresholding

T

GIS data
overlay

'

/ Flood map /
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ALOS 2 PALSAR 2 Data Calibration

°[dB] = 10log,o(DN)* + CF

oY — Radar Backscatter
DN — Pixel DN values

CF - Calibration Factor



1 Open QGIS installed on your computer

1.1 Goto Layer > Add Layer > Add Raster Layer

@ Untitled Project - QGIS

O

EY Y

BRE

E

gs e ;sc b

pe]
LAY AN RS i

R

=y

~9 B

T 8% Recent Projects
- - O ]
Favorites =
v [&] Home
[N
[ DN
v BN
ro0 R
PG
RN
v ¥
[ ZA
@ GeoPackage
£ Spatialite
& PostGls
P MssaL
@ Oracle =
Layers @®
o il & T - RO
(2 Open GDAL Supported Raster Dataset(s) X
P pp
« “ 4 |« 21JPTMworkshap » Flood_Data Myanmar > ALOS Data » 0000215585.001001 ALOS2221653250- 180701 v
Organize +  New folder
I This PC A Name Date modified Tpe Size
I 30 Objects = ALOS2221653250- 180701 WEDR1.56UD KML 168
B Deskicp [& BRS-HH-AL0S2221653250-180701-WBDR1 56UD IPG File 106 KB
: & BRS-HV-ALOS2221653250-180701-WBDR1.56UD PG File 105 K8
Documents
& bowrloas & IMG-HH-ALOS2221653250-180701-WBDR1.5GUD 7/30/2018 9:13 AM TIF File 553,937 KB
onmiees 2] IMG-HH-ALOS2221653250- 180701-WEDR1,5GUD. if.aux 10242019 10:17PM XML Document T3
b Music & 1MG-HV-ALOS2221653250-180701-WBDR1 5GUD 7/30/2018.8:13 AM TIFFile 553,037 KB
=] Pictures 5 LUT-HH-AL0S2221653250-180701-WBDR1 5GUD 7/30/2018.8:13 AM Text Document
B videos 5] LUT-HV-ALOS2221653250- 180701-WEDR1.56UD 7/30/2018.8:13 AM Text Document
) |2 summary 7/30/2018.8:13 AM Text Document
- GIC (D)
- Chathumal (F)
s New Volume (G:
= Materials-Currer
Q Type to locate (Cirl-+) Rea = chathumal (\\ke
= Kenler Aikenla) ¥
File name: |IMG-HH-ALOS2221653250- 180701-WBDR1.5GUD v\ Allfiles v
o] [ o
|
CAl

TMﬂl

1.2 Browse the path to your image

- X

(2} Data Source Manager | Raster

Mesh

Delimited Te
oPackage

Spatialite
stgreSQL
SQL

Oracle

32
. ol

Virtual Layer

reGIS Map 5

ArciGlS Feature 5

¥ scale|:29854291 |~ | (@ Magnifier | 100%

3 Select the HH polarized image [Pre-Image (18/07/01)]

Source type

0 File Protocol: HTTP(S), doud, etc,

Source

Raster Dataset(s) Data\0000215586_001001_ALOS2221653250-18070 1IMG-HH-ALO52221653250-13070 1-WEDR 1. 5GUD. if

Close Help

| Rotation

0.0° | V| Render

@ erscais @

4




@ *Untitled Project - QGIS

o, ) (=)
L4 ¢+ JS

Browser e®

LT H
Favorites

» [6] Home

[

» DA

E\

@ GeoPackage
/ Spatialite
@ postGls

P mssaL

@ Oracle

Layers B®

1653: GUD

Ready

1.4 Similarly add the Post Image =
[Post-Image (18/07/29)]

Favorites
» (5] Home
» e\

LR

v 02
@ GeoPackage

@ Oracle

Layers

HH. 180729-WBDR1.5GUD

65535
IMG-HH-AL0S2221653250-180701-WBDR1.5GUD

Processing Toolbox o®

@ Database

Q Filetools

Q@ Graphics

@ Interpolation
Q@ Layertools

@ Network analysis
@ Raster analysis
@ Raster terrain analysis
@ Raster tools

@ Vector analysis
(2 Vector creation

) Vector general

2
7
2
g
2
&

Vector table
DAL

GRASS
Models

o

OO

Coordinate | -36213,2010243 |5  Scale | 1:2035455 ~

Processing Toolbox
* A \

» Q@ Database

File tools
Graphics

» @ Interpolation
Layer tools

» @ Network analysis
» @ Raster analysis

» @ Raster terrain analysis
» Q@ Rastertools

» @ Vector analysis
» @ Vector creation
Vector general

» @ Vector geometry
» @ Vector overlay
Vector selection
Vector table

292

o

Results Viewer

@ Magnifier | 100%

Rotation 0.0°

V' Render

® EPSG:102225

@



2 Image Calibration

2.1 In Processing toolbox search bar type raster calculator.

a8 N e ennI PR R a * s

2.2 Select the Raster calculator under QGIS processing tools. BeV. /e @ 5 " @ea a0 &
Processing Toolbox @® o
¥ A

rastercalculator

~ (2 Raster analysis
1¥ Raster calculator

4
v » = -
Ghat GDAL . VB MG HH-ALOS2225793250- 180129 WEDRLSGUD
v Raster miscellaneous s
o = V¥ IMG-HH-ALOS2221653250-180701-WBOR1.5GUD
i Raster calculator L
~ & SAGA

~ Raster calculus
& Raster calculator

Coudnate -36213,201000 W Scae 10345~ @ Megrler 100% 3 Rotaton 0.0% 3V Render @ e0sGii02s

JPTM 2019 6



2.3 Input the Calibration
Expression here

2.5 Browse to the output folder
and give it a name and save it as
a .tif file

Q Raster Calculator

Parameters Log

Expression

Raster calculator

This algorithm allows performing algebraic
operations using raster layers.

The resulting layer will have its values computed

2.4 Click on this icon and select a

reference layer

[y—

JPTM 2019

I . Il s I sin /| lgto || AND | according to an expression. The expression can
contain numerical values, operators and
I / i acos I asin || In i OR | references to any of the layers in the current
project. The following functions are also
ooset || tn f[ awn || ¢ || ) | supported:
‘ | = | ‘ - ‘ | 1= | | <= | ‘ . ‘ -sin(), cosQ, tan(, atan2(), In(), log100
The extent, cell size, and output CRS can be
defined by the user. If the extent is not specified,
the minimum extent that covers selected reference
N layer(s) will be used. If the cell size is not spedified,
\_Bxression the mirimum cel size of selected reference layer(s)
will be used. If the output CRS is not specified, the
(207 log10{"MG-HH-ALO52221653250-180701-WBDR 1. 56GUD@17))-83 CRS of the first reference layer will be used.
The cell size is assumed to be the same in both X
and ¥ axes.
Layers are referred by their name as displayed in
the layer list and the number of the band to use
{based on 1), using the pattern layer_name @band
number', For instance, the first band from a layer
named DEM will be referred as DEM@1.
redefined s When using the calculator in the batch interface or
P == from the console, the files to use have to be
spedfied, The corresponding layers are referred
NDVL - | | add | save. using the base name of the file (without the full
path). For instance, if using a layer at pathjto/my/
rasterfile. tif, the firstband of that layer will be
Reference layer(s) (used for automated extent, cellsize, and CRS) [optional] referred as rasterfile. if@1.
|1 elements selected 11 .|
Cell size (use 0 or empty to set it automatically) [optional]
| 0.000000 a 2
Output extent (xmin, xmax, ymin, ymax) [optional]
| [Leave blank to use min covering extent] I
Output CRS [optional]
| Project CRS: EPSG: 102225 - MONREF_1997_UTM_Zone_47N MIE
Qutput
‘D:IZO 19/21_JIPTM_waorkshop/ResultsPre_Calib. tif | ‘
| Open output file after running algorithm
‘ 0% | Cancel
\Run as Batch Process | Run | | Close: | \ Help \ l
x| / [e] Multiple selection
* Raster calculator 1
o = 2.7 Click Run

v IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALO52225793250-180729-WBDR1.5GUD [EP5G:102225]

X

| selectal |
| Clear Selection |
| Toggle Selection |

| AddFile(s

oK |

[
2.6ClickOK =7 e |




2.8 Do the same calibration for the post image

() Raster Calculator X

Parameters | Log | R calculator

ession
Express This algorithm allows performing algebraic
s Opes rs operations using raster layers.
The resulting layer will have its values computed
IMG-HH-AL0S2221653250-180701-WBDR1,5G6UD@1 | + I > I cos | sin || logo ||  awp | according to an expression. The expression can

IMG-HH-AL052225793250-180729-WEDR1.5GUD@1 contain numerical values, operators and
‘ s ‘ ‘ | ‘ ‘ acos | | asin | | In | | OR | references to any of the layers in the current

project, The following functions are also
Cc e e [ e [ [ | s.pporiec
-sin(), cos(), tan(), atan2(), In, log10()

The extent, cell size, and output CRS can be
defined by the user, If the extentis not specified,
the minimum extent that covers selected reference
layer(s) will be used. If the cell size is not spedfied,
the minimum cell size of selected reference layer(s)
will be used. If the output CRS is not spedified, the
Expression CRS of the first reference layer will be used.

(2050 10{TMG-HH-ALOS 2225793250~ 180725-WEDR 1. 56UD@17) - 83 Ths ;el\ size is assumed to be the same in both X
and Y axes.

Layers are referred by their name as displayed in

the layer list and the number of the band to use

{based on 1), using the pattern layer_name @band

number'. For instance, the first band from a layer

named DEM will be referred as DEM@1.

When using the calculator in the batch interface or
from the conscle, the files to use have to be
spedified. The corresponding layers are referred
using the base name of the file (without the full
path). For instance, if using a layer at path/fto/my/
Predefined expressions rasterfile. tif, the first band of that layer will be
referred as rasterfile. tif@1.

| novt | Add. || save

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

|1 elements selected | |:|

Cell size (use 0 or empty to set it automatically) [optional]

| 0.000000

Output extent (xmin, xmasx, ymin, ymax) [optional]

|[LEavE blank to use min covering extent] | |7|

Output CRS [optional]

| Project CRS: EPSG:102225 - MONREF_1957_UTM_Zane_47N M| |§|
Output
|D:J‘ZOJSJ‘ZlfJPTMiworkshoprEsuHs,’PostﬁCa\ib‘tf | |:|

Open output file after running algorithm

‘ 0% | Cancel

‘R.un as Batch Process .. l Run I | Close ‘ ‘ Help

JPTM 2019



3 Speckle filterin

g

3.1 Type Despeckle in processing toolbox search bar Select the Despeckle in OTB toolbox.

3.2 Select the calibrated

pre-image fer

drop down.

3.3 Select the filter/

type as Lee

3.4 Specify radius of
the filter as 1 (3*3)

3.5 Browse to output
folder and give it a
relevant name and .tif
file type

@ Despeckle

Parameters Log
Input Image
" pre_calib [EPSG: 102225]
Spedkle filtering method
lee
Radius [optional]
1
Number of looks [optional]
1.000000
w Advanced parameters
Qutput pixel type [optional]
float

Output Image

Do the same process for the post image

Run as Batch Process...

D:/2019/21_JPTM_workshop/Results/Pre_Calib_Lee. tif

A ¥ Open output file after running algorithm

3.6 Click Run

Cancel

Run Close Help

JPTM 2019

Processing Toolbox £
*n' Ll T

|, despeckle

- & o

~ Image Filtering
&b Despeckle



Images after speckle filtering

JPTM 2019

(2 *Untitled Project - QGIS X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
= B B (V4 [ &~ 2 + D .
NEBREBRERN OLLARI PRALILEEDIS @ Lo %z =50 [T
- L g 74
B@V. AW A Qa® 20
ol
Browser @® | Processing Toolbox @®
DRY®O e OE B
. “‘ VFavorites 7.:‘ | Q fearch..
» [&) Home » () Recently used =
» O\ » ( Cartography
» [0 DA » @ Database
» 3 EA » @ Filetools
» [0 R » (2 Graphics
» [0 6A » @ Interpolation
» [ vA r Q Layer tools
> D X\ » Q Network analysis
RN » (2 Raster analysis
r Oz » (2 Raster terrain analysis =
@ GeoPackage = | S o
M Cobialita % Results Viewer @®
Layers @®
¥ BT -FAL
~ V I Post Calib Lee
W 346417
13.1913
~ V| ¥ Pre_Calib_Lee
W -33.0023
13.3295
| Q Type tolocate (ctrl+K) | Ready Coordinate | 565980,2130138 | Scale |1:2392504 |~ | (@ Magnifier | 100% |2| Rotation |0.0° 2]
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4 Re-project images into WGS84 system

4.2 Select the filtered

pre-image from the
drop down. \

4.3 Select the Target
CRS as EPSG: 4326

4.4 Specify the
resampling as Nearest
neighbor

4.5 Browse to output
folder and give it a
relevant name and .tif
file type

4.1 Type Warp in processing toolbox search bar Select the Warp under GDAL

Processing Toolbox )
¥ a (O 2 S

P

Q Warp (Reproject)

Parameters Log
Input layer

" Pre_calib_Lee [EPSG:102225]
Source CRS [optional]

Target CRS
EPSG:4326 - WGS 84
Resampling method to use
Mearest neighbour
Nodata value for output bands [optional]
Mot set
Output file resolution in target georeferenced units [optional]
Mot set
p Advanced parameters
Reprojected
D:/2019/21_1PTM_workshop/Mew/Pre_Calib_Lee_Prj.tif

+ | Open output file after running algorithm

GDAL/OGR. console call

L warp
\ - Recently used

T Warp (reproject)
= (2 Vector general
45 Assign projection
45 Reproject layer
o GDAL
* Raster extraction
% Clip raster by mask layer
* Raster projections
W Warp (reproject)
~ & SAGA
~ Georeferencing
6 Warping shapes

4

gdalwarp -t_srs EPSG:4326 + near -of GTiff D:/2019/21_1PTM_workshop/Results/Pre_Calib_Lee. tif D:/2019/21_JPTM_workshop/MewPre_Calib_Lee_Prij. tif

Run as Batch Process...

4.6 Click Run

0% Cance

Run | Close Help

Do the same process for the post filtered image
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5 Generating the pre-post difference image

5.1 Type Raster calculator in processing toolbox search bar Select the Raster calculator under QGIS tools

5.2 Obtain the difference b

etween projected pre and post

images by Inputting the
Expression as follows

5.3 Browse to the output
folder and give it a name
and save it as a .tif file

(2 Raster Calculator

Parameters Log

Expression
Layers
Output
Post_Calib_Lee
Post_Calib_Lee_Prj
Pre_Calib_Lee

Pre_Calib_Lee_Prj

Expression

“Post_Calib_Lee_Prj@1" - "Pre_Calb_Lee_Pri@1”

Predefined expressions

MDVI

Reference layer(s) {used for automated extent, cellsize, and CRS) [optional]
2 elements selected
Cell size (use 0 or empty to setit automatically) [optional]

0.000000
Output extent (xmin, xmax, ymin, ymax) [optional]

[Leave blank to use min covering extent]

Output CRS [optional]

Output
B D:/201/21_TPTM_workshopNew/Change _img. tif

| Open output file after running algorithm

Run as Batch Process

Operators

0%

sin log10 AND
asin In OR
atan ( )
1= <= =
- Add... Save..
a |-

named DEM u#tbe referred as DEM@1.
A using the ca\cﬁgﬁﬁ\r;&rc]\c@fajarye
from the console, the files to use have to be

Raster calculator

This algorithm allows performing algebraic
operations using raster layers.

The resulting layer will have its values computed
according to an expression. The expression can
contain numerical values, operators and
references to any of the layers in the current
project. The following functions are also
supported:

-sin(), cos(), tan(), atan2(), InQ), log 100

The extent, cell size, and output CRS can be
defined by the user. If the extent is not specified,
the minimum extent that covers selected reference
Iayer(s) will be used. IF the cell size is not specified,
the minimum cel size of selected reference layer(s)
will be used. If the output CRS is not specified, the
CRS of the first reference layer will be used.

The cell size is assumed to be the same in both X
and Y axes,

Layers are referred by their name as displayed in
the layer list and the number of the band to use

S SdClickianth

spedified. The corresponding layers are referred

is icon and select a

4

-

using the base name of the file (withoyse==all

path). For instance, if using a layer at| Multiple selection

rasterfile. if, the first band of that lays
referred as rasterfile. tf@1.

Post_Call

Run | Close |

/

5.6 Click Run

JPTM 2019

IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALOS2225793250-180729-WBDR1.5GUD [EPSG:102225]
Post_Calib_Lee [EPSG:102225]

Post_Calib_Lee_Proj [EP5G:32647]

ib [EPSG:102225]

Pre_Calib [EP5G:102225]
Pre_Calib_Lee [EP5G:102225]
V| Pre_Calib_Lee_Proj [EPSG:32647]

5.5 Click OK

Select Al
Clear Selection
Toggle Selection

Add File(s)
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Change Image after raster calculation

(2 *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web

Processing Help

PROGGEBOS & -K-5-5 - =z =-00-

DEERRRY O L0 851;

dbe =q@H=x9 QAR 2 0

B

MOV AW P Bk T <
i AN

Browser @®
QRET®O

' Favorites
» [&] Home
» O\
» DA
» OB\
» OR L
» 36\
»
»
»
»
»

[ImEAY
[ v
B xA
[BER'AY

Oz
| >

4

Layers @®
v @l e T -FADO

~ V| ¥ Change img
W 101880
10

Processing Toolbox

* e OF

Q. despeckle

v & omB
¥ Image Filtering
€ Despeckle

E Results Viewer

| Q Type tolocate (ctri+k) Ready

Coordinate 97.675,16.198 | ¥ Scale| 1:1854556 |~ | @ Magnifier | 100%

|2| Rotation |0.0°

|2| VIRender @ epsGiaz2s @

JPTM 2019
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6 RGB visualization of post and pre-images

6.1 Goto Raster > Miscellaneous > Build virtual raster

() Build Virtual Raster

6.2 Click this icon and select the Pre-Processed, pre and post images from this tab

\

Parameters | Log

Input layers

2 clements selected
Resolution

average

V| Place each input file into a separate band

Allow projection difference
v Advanced parameters
Add alpha mask band to YRT when source raster has none
Override projection for the output file [optional]

Resampling algorithm

nearest

Nodata value(s) for input bands (space separated) [optional]

Virtual
[Save to temporary fie]

| Gpen output file after running algorithm

GDAL/OGR. console cal

Run as Batch Process.

gdalbuildvrt resolution average -separate + nearest -input_file_list C:/Users/Chatumal/AppData/Local/Temp/processing_3a8ch347677f4af48a922a7 12ecfadéc/a0 1f7a54808 14920b796a6daeae 361 1cbuildvrtinputFiles. tt C:/Users/Chatumal fAppData/Local/Temp/processing_3aBch347677f4af48a922a7 12ecfadsc/
cfee45feb6954213b076f94187d32ba2/OUTPUT. vt

Cancel

-
K
5

Close Help

Q Multiple selection

Change_img [EP5G:32647]
Output [EPSG:32647]
IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALO52225793250-180729-WBDR1.5GUD [EPSG:102225]
Post_Calib_Lee [EPSG:102225]

v Pre_Calib_Lee_Proj [EPSG:32647]
Post_Calib_Lee_Proj [EP5G:32647]

Post_Calib [EPSG:102225]
Pre_Calib [EP5G:102225]
Pre_Calib_Lee [EP5G:102225]
RGE [EP5G:32647]

ok W

Select Al
Clear Selection
Toggle Selection

Add File(s)...

Cancel

AN

6.3 Click OK

6.4 Click Run.

JPTM 2019
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6.5 Right click on the created virtual band and select Properties > Symbology

Q@ "qgs36-QGS

DEBREY 09

ReV /80

Browser Bx

GRrY®o

Favorites
& Home

g o -

NEzeIoRe

© Onck

Layers e §

¢fe YV -320
+ [ ¥ Change img
v ¥ RGB

v V¥ Pre.Glb lee Proj
| E
EEe)
v V¥ Post Gl Lee Proj
| EE
1191
¥ Post_Calib Lee
¥ Pre_Calib Lee
¥ Pre Colib
¥ Post_Calib
o IMG-HH-ALOS2221653250-18.
¥ IMG-HH-ALOS2225793250-18...

=
B
1=

Hi=-Pm-
®R0e@ 29 B

Codrate| 4689,196371. ' Scde 1:985¢

Red Band

Blue Band

- d X
6.6 Select band 1(pre), band 2(post) from the dropdowns as follows
@ Layer Properties - RGB | Symbology
w Band Rendering
] ocessing Toolbox a8 Render type | Multiband color -
ETNE
AR Redband | Band -
A a Min |-22.2567 | Max |-2.8801
) Recenty used 4 e "
Y i— Greenband |Band 2 -
v & oA Min |-23.8757 | Max |-2.5643 |
> G Bueband  |Band2 ]
e =
F pCTtoRGe
5. RGB1oPCT Min |-23.8757 | Max |2.5643 |
¥ f:s;’ T Contiast | cyreten to MinMax -
@ icolorsenhance
i e e, et
Resats Viewer B8
B Min [ Max Value Settings
w Color Rendering
Blending mode | Normal - | # Reset |
arightness O [0 [2]] contrast O b |5
Saturation ] lo :M Grayscale | OFf ~|
Hue Colorize - strength ) [100% <]
| Kenty Results 8% ¥ Resampling
3 5. Zoomed:in | Nearestneichbour ~ | out | Nearest neighbour ~ | Oversamping (200 |3
§ Feature ke Thumbnail Legend Palette
| stk | ok || Cancel || Aply || Hep
Yade | Topdown v Auto ogen fom
15 e |
53 | v @ Ve 0% ot 000 5 VRedy Socinns @

The areas likely to be flooded will appear as red, under this particular band combination. Observing change image and this RGB visualization,
you can find the radar backscatter value range in the flood region. A threshold value can be selected for delineate the flood extent.

JPTM 2019

: Pre-image

Green band: Post-image

: Post-image
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7 thresholding the Pre, Post difference image

7.1 Input Expression as follows (threshold value for detected water selected as -3 here)

Q Raster Calculator

Parameters | Log

Expression
Layers Operators

Change_img@1 + =

Post_Calib_Lee Prj@1

Post_Calib_Lee@1 S /

Pre_Calib_Lee@1

Pre_Calib_Lee_Prj@1 ~ =3
< >

Expression

“Change_img@1" < -3

Predefined expressions

MNDVT

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]
1 elements selected

Cell size (use 0 or empty to set it automatically) [optional]
0.000000

Output extent (xmin, xmax, ymin, ymax) [optional]
[Leave blank to use min covering extent]

Output CRS [optional]

Output
D:/2019/21_IFTM_workshop/Mew /Change_img_tresh, tif
f v Open output file after running algorithm

Run as Batch Process...

0%

log10 AND
In OR

( )
<= >=

Raster calculator

This algorithm allows performing algebraic
operations using raster layers.

The resulting layer will have its values computed
according to an expression. The expression can
contain numerical values, operators and
references to any of the layers in the current
project. The folowing functions are also
supported:

-sin{), cos(), tan(), atan2{), In{), log10()

The extent, cell size, and output CRS can be
defined by the user. If the extent is not specified,
the minimum extent that covers selected reference
layer(s) will be used, If the cell size is not specified,
the minimum cel size of selected reference layer(s)
will be used. If the output CRS is not spedified, the
CRS of the first reference layer will be used.

The cell size is assumed to be the same in both X
and Y axes,

Layers are referred by their name as displayed in
the layer list and the number of the band to use
(based on 1), using the pattern layer_name:
number'. For instance, the first band layer
Save, named DEM will be referred 5
When using Filator in the batch interface or
om, nsole, the files to use have to be
tified. The corresponding layers are referred
using the base name of the file (without the full
path). For instance, if using a layer at path/to/my/
rasterfile. tif, the first band of that layer will be

a |- referred as rasterfile. if@1.
<[
| Run | Close

7.4 Browse to the output folder and give it a name and save it as a .tif file

JPTM 2019

7.5 Click Run

7.2 Click on this icon and select a

_— reference layer 3§

Q Multiple selection

V| Change_img [EP5G:32647]
Output [EPSG:32647]
IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALO52225793250-180729-WBDR1.5GUD [EPSG:102225]
Post_Calib_Lee [EP5G:102225]
Post_Calib_Lee_Proj [EPSG:32647]
Post_Calib [EPSG:102225]
Pre_Calib [EP5G:102225]
Pre_Calib_Lee [EP5G:102225]

Pre_Calib_Lee_Proj [EP5G:32647]
RGE [EP5G:32647]

7.3 Click OK

Select All
Clear Selection
Toggle Selection
Add File(s)...

| oK

Cancel
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Change Image after thresholding

! "Untitled Project - QGIS

BV w

Browser (=]
IR TR

Favorites
b [&] Home

4 A
4 Dy
4 BN
2 F\
4 Gey
4 Vi
4 K\
4 Y
2 Z\

@ GeoPacksge

Cobinl e

Layers B
« @l % T i
- W Change img tresh

Ho
1
= |¥| i Change_img
I 191880
3.02473e+38
- |v| ¥ Pre Galib Lee Prj
W 352355
117589
= |¥| B Post_Calib_Lee_Prj
W 370789

116312

W 330023

133285

1legend entries removed.

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

= E 74 | =, @ o g9 9
0 S BERE U P L LM

> Ja

Coordinate | 260773,1839595 9 Scale | 1:1878850 ~ & Magnifier | 100%

Processing Toolbox

* A k,
raster
- Recently used

Raster calculator
Polygonize (raster to vector)
¥ rto.wect
~ (2 Graphics
Raster layer histogram
~ (2 Layertools
Extract layer extent
= 1 Raster analysis
Raster calculator

Results Viewer

< Rotation | 0.0° = o .
¥ Session list




8 Converting the data type of the threshold image

8.1 Type Translate in processing toolbox search bar and select the Translate(convert format) under GDAL

Processing Toolbox 5]
*@_ L NON= %
. L Transla
8.2 Select the threshold image from the drop down. - E\ Veczmeatim

- Array of translated features

() Translate (Convert Format) x = 2 Vector geometry

4 Translate
-
Parameters | Log i GDAL .
~ Raster conversion
ol %, Rearrange bands
8 3 I. k d d 2 Change_img_tresh [EPSG:4326] M= «~ Translate (convert format)
* click on advance Override the projection for the output file [optional] ~ Raster extraction
~ B Clip raster by extent

parameters

Assign a specified nodata value to output bands [optional]
Naot set

\ Copy all subdatasets of this file to individual output fles
w Advanced parameters

Additional creation options [optional]

Profile | Default

Name Value

8.4 Change the output | (& = s |
datatype as byte T, M -

Byte

Converted
D:/2019/21_PTM_workshop/New/Change_img_tresh_int.tif

/ V| Open output file after running algorithm

GDALOGR. console call

8.5 Browse to t h € gdal_transiate -ot Byte -of GTifF D:\2018121_IPTM_workshop'lew\Change _img_iresh. if D:/2018/21_JPTM _workshop/New/Change_img_tresh_int.tF
output folder and

give it a name and
save it as a .tif file 8.6 Click Run

[ ” /

Run | Close

Run as Batch Process
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9 Application of majority filter to reduce the noise pixels

9.2 Select the t

hreshold image (Byte) from the drop down.

9.1 Type Majority in processing toolbox search bar and select the Majority filter under SAGA

Processing Toelbox

"'gt' .'.l- L) "

majority|

& Majority Filter
Parameters | Log
Grid

9 3 I n p Ut ra d i us ¥ Change_img_tresh_int [EPSG:4326]

Search Mode:

as 3 (5*5) \ [0] Square

3
Threshold [Percent]
0
Filtered Grid

D:2019/21_IPTM_workshop/New [Change_img_tresh_int_maj.sdat

A V| Gpen output fil after running algorithm
9.4 Browse Ae output folder

and give it a nam
a .sdat file

e and save it as

Run as Batch Process.

= ) Vector analysis

< 7, Basic statistics for fields
7. Statistics by categories

v ) Vector general

7. loin attributes by locatign (summary)
~ & SAGA
* Raster filter

& Majority filter

9.5 Click Run

/

R

JPTM 2019
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(-} *Untitled Project - QGIS

Project Edit Wiew Layer Settings Plugins Vector Raster Database Web Processing Help

DB RRE
LL R

Browser [&]E3]
2T HR
Favorites =
b o] Home
2 G
2 D:y
» EN\
2 F\
2 G\
L2 i
2 X\
2 ¥\
L2 \
@ GeoPackage
/7 Spatialite
@ rostals
P mssaL
Layers @&

Majority filtered image

m & @ = 4
U e P 2K

1legend entries remaved.

w3
Jﬂ

2~ /d

Coordinate | 93,225,17.536

Scale | 111594917 | ~

& Magnifier | 100%

Processing Toolbox

e o %
majority
~ (1) Recently used

@ Majority filter

v ) Vector analysis

Basic statistics for fields

Statistics by categories

= () Vector general

Join attributes by location (summary)

~ & SAGA
* Raster filter

& Majority filter

|dentify Results
2 O - e

Feature

Mode | Top down

~| Rotation |0.0°

V| Render

- x
B®
& &

Value

v Auto open form
Help

& ppsGia3ze @@



9.6 Right click on the majority filtered image> Properties

() Layer Properties - Change_img_thresh_int_maj | Symbalogy X
.
9.7 select symbology and under render type select unique values 3 _
w Band Rendering
(3 Informatio
2 Information Render type | Paletted/Unique values ~
Q Layer Properties - Change_img_thresh_int_maj | Symbology x a
— o \:\_- Source Band Band 1 T
- M e . imca
Multiband color Color ramp Random colors =
"i Information Render type R s S
Uniqueivalues Value Color Label
J\:\‘ Source - Singleband gray - l_a Transparency
= Singleband pseudocalor o 0
& Symbolagy Colorramp || piishade Random colors M gram
— T - : B
Iﬂ Transparency i Rendering
’
& Rendering
Bl vetsda & aais server
.
Legend
L 9.3 Click lassif
. IC on C aSSI y Classify oh | (= Delete All i
/ w Color Rendering
Classify = Delete All -
' Blending mode | Normal - 4 Reset
w Color Rendering Brightrx L3 0 v IConhast S —_F 0 =
Blending mode | Normal - 4> Reset Saturation —F 0 * IGrEYEG‘E off M
Brightness S | a0 = [Cmt,ast — 0 - Hue Colorize Strength ) | 100%
Saturation —— 1] = [ Grayscale | Off - v Resampling
Hue Colorize Strength _l | 100%
Zoomed: in | Mearest neighbour ~ | out | Mearestneighbour ~ | Oversampling | 2.00 |
w Resampling
Thumbnail Legend Palette
Zoomed: in | Nearest neighbour ~ | out | Nearest neighbour ¥ | Oversampling | 2.00 |5
Thumbnail Legend Palette
Style = ‘ oK ‘ Cancel Apply Help
Style oK Cancel Apply Help /

9.8 Click OK
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Classified image ( water-1, non water-0)

Q@ et s Lo 9.10 Set the format as Geotiff 9.11 Browse to the output folder
e YT T TTY Y Y . iy m. o and give it a name and save it as a
NERRERY P*2LSR PR LBEAL &6 K o-f- c@MIB-PE- / .ff.flg
sevse TTEE “aBatsn QAR 40 B tiffile  /
b ( Save Raster Layer as... X
Browser Processing Toolbox =1
e ®e085 % Outputmode (® Rawdata ed image
e O, magrty al =
g N Fomat | GeoTIFF / ~ | [ create T
» ~ @ Vectar analysis ‘ /)
- s Flename  |D:\2019\21_JPTM_workshop\New\Detected_Flood. tif all.]
Statsics by categories
) Qmmlnswm[mmmm Layer name ’ |
" S RS | EPSG:4326 - WGS 84 - ][]
€ Mty i =
'V Add saved file to map
ety Rt 28 | CurentlayerExtent | |CalulatefromLayer ~| |  MapCanvasExtent | [
LR LY
» w Resolution (current: layer) |
B Zouma NoteRescttion (002 (®) Horizontal |0.000231137 | Vertical |0.000231137 | |Layer Resolution |
gi::,:;wm () Columns | 17409 | Rows | 16742 [| Layersize
L Bemove Layer..
‘Set Layer Scale Visiility...
s D V Create Options
»  Pyramids
w V| Nodata values
T epe— ET— From To
Q Type tolcate (Ch) Coodrate 53.005,15.397 B s 1SR v @ Mege 100% 2 Romn (000 |3 ViRedw Smscas @ <] | >
H=EE |
9.13 type O /
9.9 Right click on the classified image > Export here I x || cancel || o |
> Save As / \

9.14 click OK
9.12 Add the no data value as 0 by click on this icon
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(= *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector

DB RR N
BHV. 4 W

Browser B

OETme

Favorites

Home

A

DA

EN\

F\

G

Wiy

X\

i

v 02N
" GeoPackage
/£ Spatialite
@ rostals

P MmssaL =

wivliwivizivivinl=)
IRy I I I I =

Layers &

o @ ® T |E 2= Y

~ | ¥ Detected Flood
[ B
1
- W
0
[ B

O &

1legend entries removed.

Detected Flood raster image.

Database Web Processing Help

@ w3
el

JPTM 2019

Coordinate | 93.008,16.297 % Scale | 1:1595971 =

& Magnifier | 100%

Processing Toolbox

* A .

majarity|
= (Y Recently used

@ Majority filter

= 3 Vector analysis

% Basic statistics for fields

%, Statistics by categories

= (3 Vector general

2 Join attributes by location (summary)

+ & SAGA
~ Raster filter

& Majority filter

Identify Results
- 3 - A

Feature

Mode | Top down

~ | Rotaton [0.0°

V| Render

— X
(]e]
@®

Value

V| Auto open form
Help

@ epociazs @
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10.2 Selec

10 Conversion the Detected Flood raster file into a vector file

10.1 Type polygonize in processing toolbox search bar and select the Polygonize under GDAL

t the Detected flood raster fromye drop down.

10.3 Brow
and give it
.shp file

(! Polygonize (Raster to Vector)

Parameters Log
Input layer

¥ Detected_Flood [EPSG:4326]
Band number

Band 1 (Gray)
Name of the field to areate

DN

Use 8-connectedness

Vectorized

D:/2019/21_PTM_warkshop New/Detected_water Flood.shp

v Open output file after running algorithm

se to the output folder
a name and saveit as a

GDAL/OGR console call

python3 -m gdal_polygonize D:\2019\21_JPTM_workshop'New'Detected_Flood. if D:/2018/21_JFTM_workshop/New/Detected_water/Flood.shp -b 1 f "ESRI Shapefile” Flood DN

0%

Run as Batch Process...

JPTM 2019

Cancel

Run Close Help

Processing Toolbox ]
# A (O

L polygaonize
Recently used
4 Polygonize (raster to vector)
* () Vector creation

- Raster pixels to points

- Raster pixels te polygons
* () Vector geometry

& Polygonize
v o GDAL
* Raster conversion

4 Polygonize (raster to vector)
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Detected Flood in Vector format

(X *Untitled Project - QGIS - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
g (=] B @ ) (= | ivBhv = - &8 v

NEBRRRY U@L RPPRA  BRENS & -K-5-5,658 5 #8500

LA AYAIEN - @ >0 = QE=E S Qa® 20

4
Browser ® Processing Toolbox ®
QeY®e ®e 0B N
*h Favorites = ‘ < po a
» [&] Home ~ (U Recently used 13
[ e\ #4 Polygonize (raster to vector)
» O DA ~ @ Cartography
» OB\ 4% Topological coloring
» OR ~ (2 Database
» [0 6\ 4 Export to PostgreSQL
» JvA 4 Export to Spatialite
» [ XA [ 4 PostgreSQL execute and load SQL
» OvA % PostgreSQL execute SQL
» Oz ~ @ Graphics

e GeoPackage % Polar plot

/7 Spatialite ~ (@ Interpolation

@ postGls Hi (Kernel Density Fsti »;

P mssaL = Results Viewer e®
Layers
v e TV &-FAO
| Q Type tolocate (ctri+) Ready Coordinate | 93.002,17.603 |95 Scale | 1:1665410 | v | @@ Magnifier | 100% [2] Rotation |0.0° [2] VIRender @epsciazzs @
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To make Value Added Product more informative, you can combine OSM data with these processed product.

(2 *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DB RLRX
BR@V. AW 1y

Browser @® .
ORTYHO
i Favorites
[&] Home
e\

[0 bA
[0 EA

-
L
@
=

e GeoPackage
, Spatialite
@ postals

P mssaL

Layers
L4 \@ ®, ? 8\‘ -3 & =
W roads

v| [ Buildings

v ocean_layer

V! [l Vectorized
~ V| ¥ Google Terrain

P "y

M

Bl L8
‘ Q Type to locate (Ctrl+K) ‘ 1legend entries removed.

VDPL " RAPP QI

" Taunggoh

BUS &c-K-5-0,FE# =M
;E‘
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e OB S

A po a |

~ (1) Recently used =
#5 Polygonize (raster to vector)
~ @ Cartography
4% Topological coloring
~ (2 Database
% Export to PostgreSQL
# Export to Spatialite
4% PostgreSQL execute and load SQL
# PostgreSQL execute SQL
~ @ Graphics
% Polar plot
~ (2 Interpolation
B H (Kernel Densitv Fsti
Results Viewer B®

|2| Rotation |0.0° |2| v/ Render @ epsciazze @
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Value added products after combined with more information

FLOODING IN BAGO DIVISION, MYANMAR

!)l-h II\lH‘

e

As observed by ALOS-2 image on 29 July 2018

97T°00°E

FLOODING IN BAGO AND MON DIVISION, MYANMAR
As observed by ALOS-2 image on 29 July 2018

96°00°E

19°00N

7, s;%

,& MAP SCALE 1:250,000 at A1 PRINT
N Coordinate System: GCS WGS 84
Datum: D WGS 84
Unit: Degree

Province Boundary

Waterbody

- Flood Proxy Map

Data Sources

18°300°N
17°300N

Satellite image:

Pre-disaster : ALOS-2, 1 July 2018
Post-disaster : ALOS-2, 29 July 2018
Copyright : © JAXA (2018) - All rights reserved.
GIS data:

River, Water bodies © OSM 2018
Administrative boundary ©® GADM

Service Layer Credits: Sources: Esri, HERE, DeLorme,
Intermap, increment P Corp., GEBCO, USGS, FAO,

This map shows possible massive flooding areas from
heavy rain on 27 July 2018, which has affected Bago

and Mon Division, Myanmar. Note that the detected-water
may also include water in paddy area.

700N

18°00°N

Map product made by GIC-AIT (v1.0).
Disclaimer: The accuracy of this product is not validated.

Data provider: !

96°00E
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Useful links:

OSM Data Download :  https://download.geofabrik.de/

Marine region shape file Download : http://www.marineregions.org/gazetteer.php?p=details&id=1904

Thank You!

JPTM 2019
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